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This document outlines how to configure Medication Review functionality in Kroll and the
process of completing Medication Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the Medication Review functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters |,E.|Lﬂ_hJ
General Qonfiguration| Modulesl IherapeuticAdvisorl gtationl Logging|

I Allow Electronic Signatures I Follow Provincial Legislative Rules for Fx Transfer
[C] Enable SetLaser labels
[T Allgw NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

= P

=’ Store Level Configuration Parameters

General Palientl Drug I Doctorl Rx | FDB | Adiudicationl Labelsl Fleportsl Securit_l,ll Interfacesl Elrderl X-AFII Y-Ta Do| Ectrl E

Allovs User Calors [ Ahways Show Scan [ Diizplay window ‘When Services are Dawn
Allovs Column Configuration

Prompt to exit when clozing fill application Uze automatic capitalization

Enable MH / batch . )
e - Uze Unit Dose Packaging Allow Electionic Signatures |
Default language | Engiish J Default area code Enable Ctr-FrintS creen to Print Soreenshot
Defaut Cauntry Canada ﬂ Sort A% Transfer Stores By Store Mame j

Staore Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

w’ Store Level Configuration Parameters E =

| Generall F'atientl Drug I Doctorl Rz I FDB I .-’-‘«diudicationl Labelsl Heportsl Securityl Intelfacesl Drderl ><-AF|| Y- Ta Do| [ECtrl @

| e Generall 2- F'ricingl 3- Promplingl 4 - Mursing Homel 5 - Background Fx FiIIingI E- Workflowl i- CDUHSEHHQI a- EeFI:-:|

R Caunzeling Autarnatic Patient Counzeling
Allow editing counseling time On Mew R
Require Electronic Signature Ornly flag if patient hasn't had the drugin the last 180 daps
Uszers Permitted to Finalize Accepted Counseling [C] Or Refils
Fharmacist Licersed Technician [] On Drug Changes
Pharmacist Intern Pharmacy Tech Student Allows Uger bo Turn OFF Automatic Coungeling for an Bx
Fharmacy Student Pharmacy LAssiztant
IT Suppart
Yizible Tabs
Hardcopy Tab R Images Tab
RxTab “wiorkflow Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Reguire Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews

Fequire Electronic Signature

Allow Editing Caunzeling Time

T

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

e Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based Medication Reviews using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of Medication Reviews;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled, you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic Medication Reviews

This section explains how to perform an Electronic Medication Review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper Medication Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Meds Check when the option Prompt for ODB Med Checks is enabled
under File > Configuration > Store > Rx > Prompting.

[ w Store Level Configuration Parameters || 5 )
| ﬁenerall Eatientl Diug I Dgct0r| Bx | ELB I édiudicationl I__abelsl Heporﬁsl §ecurit_l,l| lnterfacesl Drdgrl K-AHI ¥ -To Do| [Ectrl @

1- Generall 2 - Pricing| 3~ PfDthian 4 - Mursing Homel 5 - Background Rz FiIIingI E- Workflowl - Counselingl 8- Cth-:|
Drug Programs

Prampt ta use Drug Subs 7] Automatically use Drug Subs [] Participate in the Rx Canada / Health Inform Program

Usze Diug Subs when Batching

Prompt If Doctor Refuzed Repeat When Cancelling Rz [] Participate in the Pharmacy &ccess program

Prompt for Comments when Canceling an Bx [ Use Station Name Subdirectaries For Phamacy Access
[ Always require comment Days Back: 365

[ Promgt for Comments when Inactivating an R [ Enable Rix Canada Frogram (RxGateway)

[ Ahways require comment

[ Prompt for Patient Counzelling an new Rix . . . . .
7] Prompt to Batch NH Riss [ Prompt to Enral Patients in Refil Feminder or Auto Refil Program
F ) ) ) . Prompt to Enral HH Patients in Refil Reminder or &uto Refil Program
Erompl ;\'he; nat d'SES:S'n?:aS ;Irug 3 PF‘?Ck Size Frompt ta Enable Rxs for Refill Reminder and Auto Refill Program
W | Frompt For Repeats et Copying an s . . P
Enrol Patients for Pickup Natification No v
Prompt To Use Manual Price From Last R efill v J

Services

D Remove Manual Price for Batched Fixs Enrol MH Patients for Fickup Motification Mo ﬂ

[] Prompt if Doctor Autharization Received for Narcotic Rxs

[] Check far High Intensity Drugs Frompt to copy warkflow packaged info for cancel and refill Rxe
Prompt if there iz not enough inventory to fill the Ry Frompt to copy to new number if refiling an Rix with no repeats

[] Prevent Copying an Inactive Fix ta a New Mumber [ Prompt for Due Date on autofill batches

[ Show local patient profile an fill [ Prompt for Tx comment on autofill batches

Frompt to Copy "Mistake" Rxs to a New Mumber Save Routs cods from R a5 default valus if no default is set Ask |

[ Show thermal/dot matrix label config on autofil
Save Fommn code from Fie e default value if no default iz set Ak j
[ Prompt ta Print Script Image: for 1st Fill of an Unfilled Rx
[ Prompt for A4DL Plan Infarmation if $4 number iz NOT set IZ Frompt for Medication Feview I

I—| Track Medication Hewiew Hejection Reason:
Allow 'Mever Prompt’ For Medication Review

[ Promet if \Wasz Undeliverable when Cancelling an Rx

Search o OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

w’ Select an Option E =

This patient may be eligible for the Medication Assessment program.

| Add to Med Review Queue |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| Undecided |

o Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing MedsCheck ‘Saved for Later’ for further details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I Fo - Workflow “ F11 - Drop-off " F12 - New Rx " Alt-X - Start ]
Last Mame Dukes First Name George Salutation j _ Save Patient
Address1 1926 Albert Street Phone Numbers () (@I girtnaate  01,04/1908 SR
Description |Phone | All Rxs
Address 2 Age 106 years
J J Home (403) 762-1212 J Active Rxs
City Regina ~| Prov SK - Gender Male - i i
g No gpageEalable Active Rxs w/Passtimes
Postal S4M0Y2 Country Canada j Language English j
Refillable Rxs
Email Family Doctor Height 180 cm — =
Pricing Profile
Quick Code Weight 78 kg [tosa Jopate ) |- TR
ot Disp./f 3
Comments (0) (F2) (ins) [Del) pppc led i
. Rxs Filled in Error
Topic Comment
Plans (0) (E2)Es)(Ee) | g cpended Rus
| subPlan Code| Group ID | Client 1D | Expiry |
Perform FDB Analysis
View
Alternate Addresses
= Batches
Allergies (0) General } Family I Copay;] Commgnications] Other ] [t (=
R Charting
Patient Consent
Active Consent Unknown Consert
: Credit Cards
Ay |
nimal - [ Unit Dose o
Deceased On Type <Mone> j ocuments
Medical Conditions (1) Ins| — Medication Review/Dialegs (3)
- ) Prescriptions Cycle <None» j
Asthma, unspecified, with stated status ac o P 1 . Rx Counseling History

3. The Medication Review profile will appear. Click N — New Review/Dialog.

«* Patient - Helvey, Ricky P B|l= = =
File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F3 - Workflow F10 - Pickup “ F11 - Drop-off ” F12 - New Rx " Alt-X - Start
Last Name Helvey First Name Ricky Salutation j _ Save Patient
A " Profile
N - New Review/Dialog Al Rue
Medication Revicws (0] Bl | AdhveRre
Type Status Fee Status Created ¥ | Complsted o || Active Rxs w/Passtimes
Refillable Rxs
Pricing Profile

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

& Medication Review/Dialog @ﬁ

Type Medication Assessment j

I Perform uowl l Save for later l l X cancel l




\//5( KROLL Medication Reviews - Saskatchewan

Computer Systems Inc

5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

w° Medication Review Rx Selection P E|=B] X
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mcg 11-Jul-2014

Select All ] ’ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
v oK

6. The Medication Assessment screen will appear. Click Next to proceed through the tabs,
completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the Medication Assessment screen appears.
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Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions |Medica| History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

-

Who helps you with your Medication
Smoking <MNaot Answered= j
Other Micotine/Drugs <MNot Answered= j

Alcohol Intake <MNot Answereds j

m

Caffeine Intake <Mot Answered:> j

Herbals/vitamins/natural health products <Not Answered> j

Do you have trouble remembering to take medications as prescribed <Mot Answered= j
Do you think you might benefit from a compliance pack program <MNot Answered> j
Kidney Disease <MNot Answereds> j

Liver Disease <Mot Answereds j

Tetanus immunization (every 10 years) <Not Answered:> j

Influenza immunization yearly <Mot Answereds> j

Dnanmarnceal imminizatinn innadifal Mot Ancwarads |

X save for Later

Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I Naon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Patient Medical History Ins
Currently Taking 7 TAB Synthroid 112mcg [KNO] Indications
Yes j Pink Round Tab Flint 112

Dr. Moultrie, Filipe Comments
Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TABLET OMCE DAILY
Currently Taking 30 TAB Prinivil 2.5mg [MSD] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 30 Comments
TAKE 1 TAELET EVERY MORMNING
Currently Taking 7 ML Amoxicillin 50/ml [SNS] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7 Comments
TAKE 1 TEASPOOMN(SML)OMCE DAILY
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For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.

Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

Questions | Medical Historyl Non-Prescription Medications I Rxs From Other Pharmacies | General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements 1ns |[Del
Currently Taking  Claritin 10 mg For seasan allergies
Yes j

X save for Later @ Next

¢ Note if the patient is currently taking any OTC medications and select Yes/No from the
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Use Del buttons to remove any OTC items.
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Rxs From Other Pharmacies

The Rxs From Other Pharmacies tab provides space to record medications that the patient is
taking that were filled in other pharmacies.

Click Ins to add an Rx from another pharmacy.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Prescriptions From Other Pharmacies

From - Smith's Pharmacy - (555) - 123-4567

Currently Taking  Tylenol # 3 - Take 1 to 2 tablets up to 4 times a
Possible duplication of therapy

Yes j day when needed for pain

From - Duncan Mill Pharmacy - (355) - 555- 5555

Currently Taking  gisoprolol 5mg - take 1 tablet daily
Duplication of therapy

Yes -

Note if the patient is currently taking any other medications and select Yes/No from the

[ J
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Repeat the same process for any Rx items that they have purchased from other pharmacies.

Use Del buttons to remove any Rx items.
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General Comments

The General Comments tab provides space to record any comments you want included on the
report printout.

| Questions | Medical History | Non-Preseription Medications | Rxs From Other Pharmacies | General Comments | pharmacist Comments |

Pharmacist Comments

© Next

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments |

[ |
—— [ ]

7. When you are finished click Finalize Review.

10
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8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the Medication Review was physically conducted in another location (LTC facility, patient’s
home) other than the pharmacy, enter the name of the location and the address. Complete
the Other Professional Involved fields if another health professional assisted with the

review.

When you are finished, click OK.

=% Medication Review = 22

Time spent: 00:30 On 14/07/2014 By Pharmacist (P) j

Assessment Location

Name Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toranto, ON M3B 315

Other Professional Invaolved

MName T

Title Technician

Phone

| vok | | XCanceI|

11
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Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

The patient signature appears once the patient signs on the electronic signature tablet.

12
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10. Have the pharmacist sign the electronic signature tablet.

11. When you are finished, tap Done on the signature tablet.

Printing a Medication Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The Medication Review report print form will appear. Select the appropriate print options
and click Print and provide this copy to the patient.

Billing a Medication Review

14. Once printing is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the Medication Review includes a license number that is identical to the license number of
a Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

13
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File Edit Rx View Labels Profile Reports Utilities Central Fill Cards Session Help
l F3 - Patient ” F5 - Drug " F7 - Doctor l F9 - Workflow F11-D I F12 - Fill Rx I| Alt-X - Start
First Fill Last Fill Information
0/  NewRx Pending Adj 06/08/14 | 0 0 Qty 50,00 Init
Priority Default Wait Time ﬂ Due in 19 mins Forward Rx Waork Order 32 Delivery Pickup j
Patient Search Drug Search | Pack J Doc Search Loc Office j
MName |Doe, Jane Age34  |Brand Mame | Dr. Test, Doc
Address | 200 Main 5t Female | | Generic Address
City Regina Prov |SK Pack Form Sched City Prov|ON
Phone |Home (111) 111-1111 Purch OnHand |0 Mo image || Phone [(555) 555-5555
Plan  |RCMP |ClientID 010101 DIN Min Qty |0 Lic# 123 Alt, Lic#|321
Allergies Sig Medication Assessment Tnit KRL |KRL Auth Qty g
MEDICATION ASSESSMENT Disp Oty Rem Qty
.P. 0
Days 1 Ein
] Acq Cost
Conditions Prod Sel 3-Pharme v| 50,00
Coute of Adm B oW witten  v| i 5000
oute of Admin Labels 1 . o
Bosaq=lkomy =l Total 50.00

Medication Review Options

Several Medication Review options are available from the right navigation pane on the
Medication Assessment screen.

File Edit Med Review View Profile Utilities Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 off F12 - New Rx Alt-X - Start

Medication Assessment Reviewed With | Doe, Jane (In Person) [E=Tam
Print Medication Review

F9 - Workflow F11 - Dro

Patient | Doe, Jane Address | 200 Main S5t Select Rxs for review
Birth 01/01/1980 | 34 years Female | Plan | RCMP Client1D | 010101 Phone | Home (111)111-1111 View Follow Ups
Allergies Conditions View
Patient Charting
Patient Documents
Patient Med Reviews (10)
Questions | Medical Historyl Mon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments Profile
1) AR
Who helps you with your Medication Active Rs

Smoking <Mot Answered> j Active Rxs w/Passtimes

Other Nicotine/Drugs <MNot Answered> j Pricing Profile
Alcohol Intake <MNot Answereds j Mot Disp/OTC Profile

m

14
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Review

Print Medication Review
When this option is selected, the Medication Review Report screen will appear, allowing you to

set various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

=
= Medication Review Report (Medication Assessment, 2014-Aug-06) B = |

File

Options

[T Print store logo
Print Pharmacy Mame, Address and Phone number

Print Pharmacist comment

Frint at least 1 % lines for Allergies
Frint atleast 1 % lines for Conditions

Max 6 lines in total for Allergies and Conditions

Printer Microsoft XPS Document Writer j Copies 1=

Tray  Automatically Select j [¥] collate [ Duplex

Restore Defaults] [ " Erint ] [ Presview l [ x Close]
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Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the Medication Review screen. Click OK to
save any changes and Cancel to close the screen.

& Medication Review Rx Selection ®»B|lo B X
Pre-Selected (3) | Other Rxs [ Unfills { Not Dispensed | Discontinued
Rx Num Drug Fill Date
¥| 1000962 Synthroid 112mcg 14-Jul-2014
v} 1000961 Prinivil 2.5mg 14-Jul-2014
‘ v/ 1000960 Amoxicillin 50/ml 14-Jul-2014
\ Select All || Select None \
Drug lines to use in review
Drug line 1 Default ~| Drugline 2 Default ~
 OK t¥7Cancel:

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the Medication
Review has been completed. This is NOT a Medication Review Followup review.

w® Medication Review Follow-ups | P | E | | =RECE X
Medication Review Print Report
Type  Medication Assessment Completed On
Patient Taylor, Barbara Completed By

Follow-ups (0) [F2] (T (Bel)
Due Date  |Feason Brand Name FxMNurm |Resolved | -

16
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To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you
are finished, click Save.

= Medication Review Follow-Up l P B Jl | ] e
Medication Review
Type  Medication Assessment Completed On
Patient Taylor, Barbara Completed By

) Do not follow up

19! Follow up required in days =

Reason Unknown j
Comment
[CIResolved on by
Comment

I  Save I ’ X cancel ]

View
Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

« Patient Charting Bl P
Weight :Heighl Blood Pressure | Blood Sugar | Cholesterol | Creatinine CL [INR | Clozaril GI<UE]
o Weight Values (3) [F2][Ins)(Del)
2= : | |pate |weight -
il 5012013 65
o : : : ; C 0012012 60

2o f - - - : . osj0ijz011 58
200 . N i L f 2

190
180

170
160
150

o 5
Olantl 0fMartl 0ag  Olull  OfSeptl Ofovil OlJani2 OWMari2 0iMayi2 OlJulZ O01Sepi2 OlhoviZ Oidant

(owes

17
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Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

Patient Documents
When this option is selected, the Patient Document List will appear displaying a list of

documents associated with the patient.

Patient Document List & =
" e
[ Add Mew Document W
Documents (D) [F2](Ing) (Del]
Title Init |Document Type|Created v |Retain Until | ~

Med Review 20,/08,/2014

Medication Assessment

m

Description Comments [0)
Topic | Comment

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the

Medication Review queue.

%’ Patient Medication Reviews and Dialogs N B[ = B B
N - New Review/Dialog P - Print/Reprint F - Call up C - Cancel Claim ‘
F2 - View Details D - Pharmacist Declined R - Patient Refused ‘
| Medication Reviews (1) (F2) - (s
Type | Status |Fee Status | Created v | Completed | -
Medication Assessment | Pending | Review Not Completed Yet |06/08/2014 i

18
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Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the Medication Review screen is identical to the Profile menu on the
patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/ Passtimes,
Pricing Profile, and Not Disp/OTC Profile.

Completing Medication Reviews ‘Saved for Later’

1. To call up Medication Reviews ‘saved for later’ or added to the Med Review Queue via auto
prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue appears with all the Med Review records that are pending
review.

w* Patient - Helvey, Ricky P Ele @ =R

File Edit Patient Profile Reports Utilities NH Central Fill Cards

F3 - Patient J

Session  Help

[ F9 - Workflow H F10 - Pickup l\ F11 - Drop-off " F12 - New Rx H Alt-X - Start

Last Name  Helvey First Name Ricky Salutation j oK [ % scan ] Patient
. Profile
N - New Review/Dialog P - Print/Reprint R All Rxs
F2- View Details D - Pharmacist Declined R - Patient Refused
Active Rus

Medication Reviews [1)
Type |Shﬂus
Medication Assessment Pending

Created ¥ IComp\eted I -
06/08/2014

Mctive Rxs w/Passtimes

Refillable Rxs

I Fee Status
Review Mot Completed Yet

Pricing Profile

c) Select the Medication Review record you want to complete and click F - Call Up.

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

I F3 - Patient ‘ F5 - Drug | F7 - Doctor ‘ F11 - Drop-off

Alt-X - Start

d : . . P - Print/Reprint F - Call up : £ Refresh _' Workflow Actions
Me Ication ReV|eWS D - Pharmacist Declined R - Patient Refused  space - Mark Rxs R¥'s To Do

Dukes, George
Dukes, George
Dukes, George

Medication Assessment
Medication Assessment
Medication Assessment

Pending
Printed Paper
Completed Electronic

Review Mot Completed Yet 07,/08/2014
Review Mot Completed Yet 06/08/2014
Pending Claim 06/08/2014

06/08/2014

Patient | Type | status | Fee Status |Created | Completed | » = Rx'sIn Progress

Dukes, George Med!cat!on Assessment Pend!ng Review Not Completed Yet 15/08/2014 Pending Adjudication (0)
Dukes, George Medication Assessment Pending Review Not Completed Yet 07,08/2014

Dukes, George Medication Assessment Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Trouble (0)

Dukes, George Medication Assessment Completed Electronic  Pending Claim 07,/08/2014 07/08/2014

Rx Counseling (2)
Medication Reviews (9)
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2. Complete steps 3-8 of the Creating an Electronic Medication Review section.

Sample Electronic Medication Review Report

Medication Assessment : '\-‘\
A= _/ pE—
. SASKATCHEWAN
NI A EMEHT PRIERNA
Name Gender Date of Girth
Doe, Jane Female 01-Jan-1980
Adoress Phone PRI
200 Main St, Regina SK M1M 1M1 (111)111-1111
FamilyDoctor Family Doctor Phone Family Doctor Fax
Allergies
Conditions
Smoking Alcoholintake Caffeing Intake Otheddicotine/Drugs

CINo [ Yes, # cigarettes/day: e [ ves, # drinksfweek: o [ ves, # cupsiday: Cne [es:

Health Information

Herbalshitamins/naturalhealthproducts ves | Mo | Doyou have trouble remembering to take medications as prescribed Yes| No
KidneyDisease Yes| No | LiverDisease Yes| No
Tetanusimmunization (every 10 years) ves| Mo | Influenzaimmunization yearly Yes| No
Pneumococcalimmunization(one/life) ves | Mo | Doyou thinkyou might benefit from a compliance pack program Yes| No
ChenmmumzZanon s aVeNaCeines
VVTiat 15 yOUT DIGOE ST CONCEn SD0UT yOUr MECICETONS [008y
NameofMedlcgtlon Strength/Dose Howtotaket!ns Medlcallop Purpose Comments Prescriber
Brand/Generic (freguency, timeofday, etc.)
Actonel 30mg-30TAB |TAKE 1 TABLET ONCE DAILY Dr. Test, Doc
A.C.BC 375/8/15mg-  |TAKE 1 TABLET ONCE DALLY Dr. Test, Doc
30TAB
The Fi ists"A iation of Sask in jon with the Canadian Phamacists Association
hawve adapted the CPhA PhamaCheck™ program.  The PhamaCheck™ Jogo is @ tredemark
of the Canadian Phammacists Association and is used under icense.
Page 1of2
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Medication Assessment

Accuracy ofthis listis dependent on the truthfulness and completeness ofinformation provided by the patient and it remains at alltimes the patient's responsibility to advise their
pharmacist of any change to their medications. By signing this, | consent for my pharmacistto share this medication listwith my other health care professionals (present andfuture)
toenhance seamless continuity of care.

Patient Signature Date Kroll
The P ists’ A iation of Sask in ion with the Canadian Phamacists Association r‘fn i
have adapted the CPhA PhamaCheck™ program.  The PhammaCheck™ logo is 3 trademark = ) @
of the Canadian Phammacisis Association and is wsed under icense, F L

Page 2 af 2
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Viewing a Completed Medication Review

With Electronic Signatures Enabled
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

e X scan

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow F11 - Drop-off “ F12 - New Rx “ Alt-X - Start ‘
Last Name Doe First Name Jane Salutation Ms. j QK Sa
N - New Review/Dialog P - Print/Reprint F - Call up
F2 - View Details
Medication Reviews [10]
Type |Status |Fee Status Created ¥ [Completed |
Medication Assessment Completed Electronic Pending Claim 06,/08/2014 06/08/2014

(F2) (ing] (Bel)

-

4. The Medication Review View screen will appear. Click the various tabs to see the

Medication Review information that has been entered.

Medication Review View |E|&J
Medication Assessment
Created 06-Aug-2014 01:52 PM | Status  Completed Electronic Fee Status | Pending Claim Fee Rx N/A
Started 06-Aug-2014 01:50 PM | Duration  Reviewed By | Kroll View Signatures Print
Completed | 06-Aug-2014 01:53 PM | 2m 23s | Reviewed With | Doe, Jane (In Person)

Questions | Medical History | General Comments | Pharmacist Comments | Non-Prescription Medications | Rxs From Other Pharmaciesl

Who helps you with your Medication

Smoking <MNot Answered>

Other Nicoting/Drugs <Mot Answereds>

-

5. Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or

patient’s electronic signature.

Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.
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The Medication Review View screen will appear. The Review tab displays information
entered on-screen during the Medication Review; the Documents tab displays the scanned

image of the signed Medication Review. Scanned paper Medication Reviews is also viewable
from Patient Documents.

Medication Review View - -—. - - B X4
Medication Assessment

Created  30-Jul-2014 02:25 PM Status Completed Electronic Fee Status  Claimed

FeeRx 1087677
I| Review Documentsl

Started 30-Jul-2014 02:25 PM Completed

30-Jul-2014 02:26 PM Duration | 1mOs

Print |
Reviewed With ' Belfer, Scott (In Person)

Reviewed By 'Scott Belfer

Questions | Medical History | General Comments | Pharmacist Comments | Non-Prescription Medications | Rxs From Other Pharmacies

Who helps you with your Medication

-

Smoking <Not Answered>

Other Nicotine/Drugs <Not Answered>

5. Click Print to print the Medication Review.
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Paper Medication Reviews

This section explains how to perform paper Medication Reviews. Paper Medication Reviews
must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

.
=¥ Store Level Configuration Parameters

=)

| Qenerall Eatientl Drug | Dgctor|

Rix | EDE | Qdiudicationl Labelsl Hepor_tsl ﬁecurityl 1nterfaces| Drdgrl K-f-‘«Hl Y-Ta Dol

[ ctr [=

1- Generall 2 - Pricing| 3~ F'mmpting| 4 - Mursing Homel 5 - Background R FiIIingl E- Workflowl i- Eounselingl 8- EeHH|

Prompt to uge Drug Subs [T Automatically use Drug Subs
IJze Drug Subs when Batching
Prampt If Doctor Fefused Repeat when Cancelling R=
Frompt for Comments when Cancelling an B=
[ Abways require comment
[] Prampt for Comments when Inactivating an R
[ Always require comment
[] Prampt for Patient Counselling on new Rx
[] Prompt to Batch MH Rxs
Prampt when not dispenzsing as dug's Pack Size
Frompt For Repeats “When Copying an Bx
Prompt Ta Use Manual Price From Last Refil
[7] Remaove Manual Price far Batched Rxs
[] Prampt if Doctor Autharization Received for Marcotic Rxs
[7] Check for High Intensity Drugs
Frampt if there is nat enough insentary to fill the R
[] Prevent Copying an Inactive Rx to a Mew Murmber
[] Shaw lacal patient prafils on fill
Frompt to Copy "Mistake' Bz to a Mew Mumber
[] Shaw thermal/dat matrix label config on autafil

[] Prampt to Print Script Image for st Fill of an Unfilled Fix
[] Prampt for AA0L Plan Infarmation if 54 number is NOT set

[] Prompt if “was Undeliverable when Canceling an R

Drug Programs
[] Participate in the Rx Canada / Health Inform Program

[] Participate in the Phaimacy Access program
[7] Use Station Mame Subdirectaries For Pharmacy Access
Daysz Back: 365

[7] Enable Rx Canada Program [R=G ateway)

Services
[] Prompt ta Enral Patients in Refil Reminder or Auta Refil Program
Frompt to Enrol MH Patients in Befill Reminder or Auto Refill Frogram
Prompt to Enable Ruz for Refill Reminder and Auto Refil Program

Enrrol Patients for Pickup Matification Mo j
Errol MH Patients for Pickup Motification Mo j

Prampt to copy warkflow packaged info for cancel and refill Rxs
Frompt to copy to new number if refiling an Bx with no repeats
[] Prampt far Due D ate an autafil batches

[] Prampt far Tx camment an autafil batches

Save Route code from Ry a3 default value if no defadlt is set Ask j

Save Form code from Fx as default value if no default is st Ask j

|7] Prompt for Medication Review |
|| Track Medication Review Hejection Beason:
Allow ‘Merver Prompt’ For Medication Besview

Search " DK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

= Select an Option = P

This patient may be eligible for the Medication Assessment program.

l Print Report Now J
[ Print Report Later ]
[ 1 have Other Rxs to fill for this patient ]
[ Do not prompt me until the next time the patient comes in. ]

[ Do not prompt until ... ]

| Mever Prompt for this patient |

e Print Report Now: This will call up the Medication Review report so you can select the
items you would like to print on the report.

e Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing MedsCheck
‘Saved for Later’ for further details.

o | have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs
for the patient before printing the report.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.
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Creating a Paper Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Ublities Cards  Session  Help
F3 - Patient F5 - Drug F7 - Doctor I F3 - Workflow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
i Cave Patient
Last Name Dukes First Name George Salutation - _ Save x Scan
Profil
Address1 1926 Albert Street Phone Numbers (1) Eirthdate 01,04/1908 bl
Description |Ph0ne | All Rxs
Address 2 Age 106 years
J J Home (403) 762-1212 J Active Rxs
City Regina w| Prov SK - Gender Male - i i
9 - No image available Active Rxs w/Passtimes
Postal SAN 0Y2 Country Canada j Language English j
Refillable Rxs
Email Family Doctor Height 180 cm X X
Pricing Profile
Quick Code weight 78 kg [ toad ] Deiete | Mot Disp/OTC Roc
ot Disp./ 3
Comments (0) ABBC H
. Rxs Filled in Error
Topic Comment
Plans (0) Suspended Rxs
|subPlan Code| Group ID | Client 1D | Expiry |
Perform FDB Analysis
View
Alternate Addresses
- Batches
Allergies (0) General l Family ] Copaygl Commgnicationsl Other l (CIE
- Charting
Patient Consent
Active Consent  Unknown Consent
Credit Cards
A |
nimal [ Unit Dose D "
Deceased On Type <None> j ocuments
Medical Conditions (1) P Medication Review/Dialogs (3)
Prescriptions Cycle <None> -
Asthma, unspecified, with stated status a: - Fx Counseling History
Delivery Type  Default (Pickup) j Price Group  <Default> (<None>)v|

3. The Medication Review queue will appear. Click N — New Review/Dialog.

¥ Patient - Helvey, Ricky ® B == K
File Edit Patient Profile Reports Utilities NH  Central Fill Cards Session Help
F3 - Patient F3 - Drug F7 - Doctor Fa - Workflow F10 - Pickup " F11 - Drop-off “ F12 - New Rx " Alt-X - Start
Last Name Helvey First Name Ricky Salutation j _ o Patient
- - Profile

N - New Review/Dialog All Rs

Medication Reviews (0] Active Rxs

Type Statuz Fee Status Created ¥ | Completed o | Active Rxs w/Passtimes

| | Refillable Rxs

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Print Now. If you wish to add to the Med Review queue in order to print the
Medication Review later, click Save for Later.

B3
-l

©° Medication Review/Dialog

Type  Medication Assessment

I Print Mow I lgaveforlater] ’ X cancel ]
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

¥ Medication Review Rx Selection e =B8] =
Pre-Selected (3) | Other Rxs | Unfills | Mot Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112meg 11-Jul-2014
Select all ] [ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
7ok

6. The Medication Review Report form will appear. Select the appropriate print options and
click Print. The report will generate.

Complete the Medication Review on the form. Sign the Medication Review Report and
have the patient do the same.
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Scanning Medication Review Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]
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10. When scanning is complete, the screen will indicate how many pages were scanned
successfully and how many will need to be manually reconciled. When you are finished,
click Process and Reconcile.

Import Scanned Documents |E| | B |
Scanner
Scanner  FUJITSU fi-6130Zdj #2
Maode Colour
Resolution 100 Scan both sides of paper [C]

Document Processing

To Process 0 I Process and Reconcile I

To Reconcile 0

[ X Close ]

l View Scan History l

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will
appear in the Documents to be created section. Items that need to be reconciled will
appear in the Unprocessed Images section.

& Document Scan Reconciliation

Documents to be created (1)
Status

Scanned on

11/07/2014 12.31:43 | Ready To File | Patient Med Revied | Doe, Jane
B & 7 |zooms00 % @ @ ARBED @ Unprocessed Images (0)| Current Document
» | Document Images (2) O (AR (29
Nedication Assessment Scanned On{ Type #l Info Message -
1231:43 | Patient Med Revied 1]
1231:45  Patient Med Revie 2
Tama Toade we TE
Dos, Jane Tenak 01k 1980
i 200 Main St. Regiaa SX MIM1INL e (anura
Famocks TonTy oy e Fomvy Laiw Fan
- E
Trcan: e THere e TCRedcEretr e
Ot Ovesommesar |4 (vssomowe |0 Jvessasser e Cres
Mealt? Irfornatios
e ] wor w ~
ey Os eass Yo | 40 | LaDiseane You| %o
Totarusimmuncaton (evey 1) ywan) You | W | PELRZICTRADIBN R0y vor| ne
PoounCCOcCaRmTINTIBON Che e e | v | D 700 T yo8 IOM Senelt 1O 3 cONPRINGE £3CE POJRT ves| %o
T
e | urengnoos '_‘:"'Qm““‘“_‘"c s Popeae Comments escatar .
Actoosl 2009 -J0TAS | TA I TARIT ONCI OAR" Or. Tes, On¢
ACAC BT [P . Forc, Onc Document Type Patient Med Review j
Patient =
» yv—) PO Ty Sp— Name Doe, Jane DOB 24/10/1950
T SR T & o ¥ :
Pae1e2 & Address 200 Main St
City, Prov Regina, SK
Med Review
11/07/2014 - Medication Assessment (Printed Paper) :]
Brightness Contrast Saturation
0 0 0 [ X cancel] |  Next ]
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a Medication Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.
Completing Medication Reviews ‘Saved for Later’

1. To call up Medication Reviews ‘saved for later’, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue appears with all the Med Review records that are pending

review.
= Patient - Helvey, Ricky T Ella @ b4
File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient FE ) F tor [ F9 - Workflow H F10 - Pickup F11 - Drop-off H F12 - New Rx H Alt-X - Start
Last Name Helvey First Name Ricky Salutation j ok - . scan | Patient
: ~ ¥ Profile
N - New Review/Dialog P - Print/Reprint F -Call up 2=l Lo All Rxs
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews (1) (72) {ins) (0a]) ctive Rus
Type lSldus IFee Status ICraaled hi lCDmpIeted I - Active Rxs w/Passtimes
| Medication Assessment Pending Review Not Completed Yet 06/08/2014 Refillable Rxs
Pricing Profile

c) Select the Medication Review record you want to complete and click F - Call Up.
F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

l F3 - Patient F5 - Drug F7 - Doctor ‘ FO - Workflow F11 - Drop-off F12 - New R Alt-X - Start

M d - R . P - Print/Reprint #> Refresh | Workflow Actions
e [catl on evIEWS D - Pharmacist Declined R - Patient Refused space - Mark Rxs Rx's To Do

Patient | Type | status | Fee status |Created | Completed| » ~ Rx'sInProgress
Dukes, George Medication Assessment Pending Review Not Completed Yet 15/08/2014

B A icati
Dukes, George Medication Assessment Pending Pending Adjudication (0)

Review Not Completed Yet 07/08/2014
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2. Complete steps 4-14 of the Creating a Paper Medication Review section.

Sample Paper Medication Review Report

Medication Assessment

TCHEWAN
Y EENIHT FDERNA

Hame
Test, Pat

Gender
Male

Date of Birth
01-Jan-1955

Address
ON

Fhone

FHN

FamilyDoctor

Family Doctor Phone

Family DoctorFax

Allergies

Conditions

Alcohollntake
[ne [Jves,# drinksiweek:

Smoking
[One [ ves, # cigarettes/day:

Caffeing Intake
[nNe []ves, # cupsiday:

One [Jves:

Othemicotine/Drugs

Health Information

Herbalshitamins/naturalhealthproducts ves| Mo | Doyou have trouble remembering totake medications as prescribed Yes| No
KidneyDisease Yes| Mo | LiverDisease Yes| No
Tetanus immunization (every 10 years) Yes | No | Influenzaimmunization yearly Yes| No
Pneumococcalimmunization{ene/life) ¥es| Mo | Do you think you might benefit from a compliance pack program Yes| No
OmEnmmUMZENonaraVENECCINES
TThat IS your Ergges concern EEDUE}’DUF mEEn’CEEfDﬂSEﬁEE}’
NameofMedicgtion Strength/Dose Howtotakethis Medicat\o? Purpose Comments Prescriber
Brand/Generic (freguency, timeof day, etc.)
Methyldopa 500mg-30 TAB | TAKE 1 TABLET OMCE DAILY Dr. Test, Doc
Elite 205TR TAKE 1 TABLET OMNCE DAILY Dr. Test, Doc
AHydrocort Inj 100mg/vial- 30 |TAKE 1 Dr. Test, Doc
ML
Apo-Ciproflox 500mg-30 TAB | TAKE 1 TABLET OMCE DAILLY Dr. Test, Doc
292 30mg-30TAB |TAKE 1TABLET ONCE DAILY Dr. Test, Doc
Page 1 of 2
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Medication Assessment
NameofMedication Howtotakethis Medication .
Brand/Generic Strength/Dose (frequency, time of day, etc.) Purpose Comments Prescriber
Lipitor 80mg-3 TAB ASDIRECTED Dr. Test, Doc
Generallomments
PATIENT FOLLOWUP
Date Reason Comments

Accuracy of this listis dependent on the truthfulness and completeness ofinformation provided by the patient and itremains at all times the patient's responsibility to advise their
pharmacistof any change to their medications. By signing this, | consent for my pharmacistto share this medication listwith my other health care professionals (presentandfuture)
to enhance seamless continuity of care.

ca iation of S

Patient Signature

2 in

The P i
have adapted the CPhA PhamaCheck™ program.  The PhamaCheck™ logo is 3 trademark
of the Canadian Phamacists Association and is used under license.

with the Canadizn Phamacisis Association

Date

Page 2 of 2

Kroll
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Viewing a Completed Medication Review

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.
3. Highlight the completed Medication Review and click F2 - View Details.

4. The Medication Review View screen will display the scanned image of the completed
Medication Review. Scanned Medication Reviews are also viewable from Patient

Documents.

Medication Review View - ] P
Medication Assessment X Close
Created 30-Jul-2014 02:34 PM Status Completed Paper Fee Status | Claimed Fee Rx| 1087678

[ 2014-07-30 239 PM

B & F|zoomes3 %@ @[O0 0H &6

Madicatlion Assessmant A
—r

«;‘.‘;“é AN

=7 NN S SELTRTLY

Narme Gander Cute of Dinh
185T, KAt mak UL-JEN-193
1rRss Hhow LHN
on
SamilCocir Faindy COctr Fnong Fomliy DReSIor e
Alleies
Tardibcns
moling Aleondinthic Toancinanc S I s
O T ves, # ugerelesigey, O [ ves # anssraes, “Iwe [Oves, o copsiaay Owe [rves.
licath Infcrmation
Hemalshtarinonatrarealthproduck: Ve No | L vou hovetrouclz remombennjtolake medizot onc o orocenice s Yoo | iz
<Idi wrCisy dsw YmE NG| LMOID SDESD Yez| it
Tataruz Immronizadlcn (svery 10vazrs] Vzz A | ITUsrzalmmurizat o1 veans Yea| s
Irearmacocezlimmunizatior (on e vae b | Doveu th nkycu mchibenefrfom a canplance pact pragrem Veo| s
TRV BTGNS SV RELOTES
I P DR LN v Lay
-

Brightness Contrast Saturation

33



Computer Systems Inc

\//X KROLL Medication Reviews - Saskatchewan

Declined and Refused Medication Reviews

This section explains the process for recording Medication Reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click D — Pharmacist Declined.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor | F9 - Worlflow ” F11 - Drop-off ” F12 - New Rx ” Alt-X - Start
Last Name  Test First Name Pat Salutation j oK Save X cancel

N - New Review/Dialog P - Print/Reprint

F2- View Details D - Pharmacist Declined R - Patient Refused

Medication Reviews [16] [F2] (Tng] (Dal]
Type |Status |Fee Statuz Created ¥ | Completed | -
Medication Assessment Printed Paper Review Mot Completed Vet 06/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

( = Select an Option |E|Lé]

Decline/Refuse - Medication Assessment.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Never Prompt for this patient |

| Cancel |

e If you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.

e If you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e [f you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.
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Patient Refused

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click R — Patient Refused.

F3 - Patient

Last Mame Test

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F11 - Drop-off “ F12 - New Rx “ Alt-X - Start

F5 - Drug F7 - Doctor l F9 - Workflow

First Name Pat salutation j oK Save X cancel

N - New Review/Dialog P - Print/Reprint

F2- View Details D - Pharmacist Declined R - Patient Refused

Medication Reviews [16] [F2] (Tns) (Del)
Type |Status |Fee Statuz Created ¥ |Completed | -
Medication Assessment Printed Paper Review Mot Completed Yet 06/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

# Select an Option
P

=35

Decline/Refuse - Medication Assessment.

I Do not prompt until the next time the patient comes in. ‘

I

Do not prompt until ... ‘

I

Never Prompt for this patient ‘

Cancel ‘

o If you select Do not prompt until the next time the patient comes in you will be
prompted to specify if the review was declined by the Patient or Someone Else.

If you select Someone Else, the Medication Review/Dialog Refusal form will

o
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to
patient menu and click OK.

( ° Medication Review/Dialog Refusal |E| [&J

Refused By _) Patient @ Someone Else

Select agent Doe,Jane j
Last name Doe

Eirst name Jane

Relationship to patient@ ~|

I V' oK I IXCanceI‘

o No further action is required until the next time the patient visits the pharmacy.
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e [f you select Do not prompt until... you will be prompted to specify the next time you

want to be prompted for the patient’s Medication Review. Complete the form and click
OK.

e If you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.

NOTE: Medication Review records that have been either refused/declined by the pharmacist
or patient cannot be deleted from the Medication Reviews queue.

Medication Review Statuses

This section explains the statuses that appear in the Medication Review queue at various
stages throughout the Medication Review process.

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Docto F9 - Workflow F11 - Drop-off F12 - New Rx ‘ Alt-X - Start l

Last Name Doe First Name Jane Salutation Ms. j 0K | I x Cancel I Patient

~ Y Prefile
N - New Review/Dialeg P - Print/Reprint F - Call up All Rxs
F2- View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews (5) [FZ] (Ins) (Del] ctive R
Type Shalus | Fee Status | Created ¥ |Completed | + | Active Rus w/Passtimes
Medication Assessment Pending Review Not Completed Yet 19/08/2014 Refillable Rxs
Medication Assessment Printed Paper Review Not Completed Yet 31/07/2014
Medication Assessment Completed Electronic Pending Claim 06/08/2014 06/08/2014 o ||| Pricing Profile
Medication Assessment Declined by Pharmacist No Fee Applicable 11/07/2014 11/07/2014 Not Disp./OTC Rxs
Medication Assessment Refused by Patient No Fee Applicable 19/08/2014 19,/08/2014 Rxs Filled in Error

Pending
Reviews that have been initiated but have not yet been completed.

Printed Paper
Reviews that have been printed but have not yet been billed.

Completed
Reviews that have been printed and billed.

Declined by Pharmacist
Reviews that have been declined by the pharmacist.

Refused by Patient
Reviews that have been refused by the patient.
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Fee Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Dru F7 - Doctor F9 - Workflow F11 - Drop-off “ F12 - New Rx “ Alt-X - Start

Last Name Doe First Name Jane salutation Ms. ﬂ | oK W x cancel Patient

, ; , i o o Profile
N - New Review/Dialog P - Print/Reprint F - Call up ancel Cla All Res
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews (3) Famsps Ve
Type IStatus Fee Status Created 7 |Completed I » | Active Rxs w/Passtimes
Medication Assessment Pending Review Not Completed Yet 19/08/2014 Refillable Rxs
Medication Assessment Refused by Patient Mo Fee Applicable 19/08/2014 19,08/2014 — -
Medication Assessment Completed Electronic Pending Claim 06/08/2014 | 06/08/2014 =| | Pricing Profile

Review Not Completed Yet
Reviews that have been initiated but have not yet been completed.

No Fee Applicable
Reviews with no associated fees (usually declined or refused reviews).

Pending Claim

Electronic reviews: Completed reviews with a Status of Completed.

Paper reviews: Reviews that have been printed and the option Require Document scan to
complete Paper Med Review is off, and reports that have been printed and scanned back into
the system if this option is enabled.
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